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Introduction
Thank you for purchasing the Canon Network Camera Server VB150 (referred to hereafter as the
VB150).
This manual describes some specific examples of the operation of the video distribution functions
using the VB150. Pictures can be automatically recorded in response to input from an external
device or detected motion, or according to scheduled settings. The recorded pictures can then be
displayed on a website. Read this manual carefully before using the VB150 to ensure effective
operation.

Exclusion of Liability
If the Product is connected to a recording device (for example a VCR), Canon Inc. accepts no
responsibility whatsoever for any financial losses that may be incurred as a result of the loss of
recorded information or images, regardless of the internal or external cause of the loss.

Copyright Information
Video or still pictures recorded using your VB150 cannot be used in ways that infringe copyright
laws or without the consent of the owner, unless intended for personal use only.

Notes
1. The unauthorized transfer of all or any part of the contents of this Manual is forbidden.
2. The contents of this Manual are subject to change without notice.
3. Every effort has been made to ensure that this Manual is flawless. However, if you find any

oversights, please let us know.
4. Notwithstanding above, Canon accepts no liability for any results arising from the operation of

this product.

Trademark Notices
● Canon and Canon logo are registered trademarks of Canon Inc.
● Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States

and other countries.
● Windows is legally recognized as Microsoft Windows Operating System.
● Java and all Java-based marks are trademarks or registered trademarks of Sun Microsystems,

Inc. in the United States and other countries.
● Other brand or product names in this manual may be trademarks or registered trademarks of

their respective companies.

Request concerning disclosure of live videos
With respect to the disclosure of live videos, we request that sufficient consideration be given to
matters of privacy and rights not to be photographed. Canon considers the following points concerning
such matters when it operates camera sites for which it has been responsible to install and operate:
- We take measures such as adding limitations on zoom magnifications so that people cannot

make special specifications.
- When videos are taken of specific buildings, interiors and the like, we install the camera only after

receiving approval from the administrator.
Please note that the operator of the camera site and not Canon has full responsibility regarding the
disclosure of live videos.

© Copyright 2004 CANON INC.
ALL RIGHTS RESERVED
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Using the Still Picture Recording Function Linked to an External Device

This is a monitoring system in which the lighting unit needed to take pictures switches on when the

door opens and the VC-C4R camera mounted on the ceiling captures still pictures. The equipment

shown in the figure below is connected to the terminals on the rear of the VB150 at installation.

Sample application in combination with a door-opening sensor and lighting unit

By using the “External Device Input 1/2” setting and connecting devices such as sensors and switches to

the VB150, you can construct a monitoring system that operates in response to external events. The still

pictures captured in this way are stored on a flash memory card inserted into the VB150. (→ VB150 User’s

Manual P.48)

Installation Example

When the door opens and

Sensor B moves away from

sensor A, external device

input In1 generates an ON

event.

In response to this event,

Out1 is controlled to switch

on the lighting unit, pictures

of the entrance are captured

by the camera and the

pictures are stored on a

flash memory card.

VB150 Connection Example

a
Warning

● Do not directly connect the power cord for

the lighting unit to OUT1 or OUT2.

● Please also refer to page 106 of the VB150

User’s Manual.
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Settings specified on the “Camera and Video” page (→ VB150 User’s Manual P.42)

Specify the appropriate settings for the Camera 1 being used.

Settings specified on the “Preset” page (→ VB150 User’s Manual P.47, 77)

Set a camera angle that records the open doorway as Preset 1.

Settings specified in “External Device Input 1/2” (→ VB150 User’s Manual P.50)

● Set the recording time from 17:00 to 6:00.

● Give priority to “Recording triggered by external device”.

● Set the camera position for recording to Preset 1.

● Set the light to switch on when the door opens and to switch off 20 seconds after the door closes.

● Pictures are recorded 4 seconds before the door opens. The lights are not yet turned on.

● Record pictures for 8 seconds after the door closes.

● Record pictures at 10-second intevals while the door is open.

Sample Still Picture Recording Settings

● Delete the recorded pictures at 12:00 on the next day. In this case, delete the pictures recorded in

the morning at 12:00 on the next day, and delete the pictures recorded in the afternoon at 12:00

two days later.

2
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Using the Still Picture Recording Function with a Predetermined Schedule

This is a monitoring system of the type used in art galleries and similar facilities in which the

exhibits are monitored in the hours they are unattended. The light switches on and still pictures

are captured at 10-minute intervals by a VC-C4R camera mounted on the ceiling. The equipment

shown in the figure below is connected to the terminals on the rear of the VB150 at installation.

Sample application in combination with a lighting unit

By using the “Schedule 1-4” setting, you can construct a monitoring system that records pictures according

to a predetermined schedule. The still pictures captured in this way are stored on a flash memory card

inserted into the VB150. (→ VB150 User’s Manual P.48)

Installation Example

In accordance with the predetermined

schedule, Out1 is controlled to switch

on the lighting unit, pictures are

captured by the camera and the

pictures are stored on a flash memory

card.

VB150 Connection Example
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Settings specified on the “Camera and Video” page (→ VB150 User’s Manual P.42)

Specify the appropriate settings for the Camera 1 being used.

Settings specified on the “Preset” page (→ VB150 User’s Manual P.47, 77)

Set a camera angle that records the exhibit as Preset 1.

Settings specified in “Schedule 1-4” (→ VB150 User’s Manual P.52)

● If you are not using recording triggered from an external device, leave the default priority

(“Recording triggered by external device”) unchanged.

● Set the camera position for recording to Preset 1.

● Insert a 5-second delay before recording to allow the camera to stabilize in the recording

position.

● Set the light to switch on when recording begins and to switch off 10 seconds later.

● The recording time frame is from 20:00 to 06:50. Since recording occurs daily, set the recording

start time from 0 to 6 and 20 to 23 every day of every month and choose every 10 minutes.

● Clear the “Apply the following repetition options at start time” selection.

To select more than one, click

selections while holding down the

Ctrl key. (→ VB150 User’s Manual

P.52)

Sample Still Picture Recording Settings

● Delete the recorded pictures at 12:00 on the next day. In this case, delete the pictures recorded

in the morning at 12:00 on the next day, and delete the pictures recorded in the afternoon at

12:00 two days later.
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Using the Motion Detection Function with a Predetermined Schedule

In this monitoring system, a warning tone is emitted when someone enters through the door and

the VC-C4R camera mounted on the ceiling captures a still picture. The figure below shows the

equipment that is installed and connected to the rear panel on the VB150.

Sample application in combination with a warning device

By running the motion detection function according to a schedule, you can construct a monitoring system

that records pictures in accordance with a preset schedule and that operates in response to variations in

the video image from the area covered by the camera. The recorded pictures are stored on a flash memory

card inserted into the VB150. (→ VB150 User’s Manual P.82)

Installation Example

When the camera shooting the area

inside the door detects a change, an

ON event occurs.

In response to that event, a warning

tone is issued by the Out1 control, the

camera shoots a picture of the

entrance and the pictures are stored

on a flash memory card.

VB150 Connection Example
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● Do not directly connect the power cord for

the warning device to OUT1 or OUT2.

● Please also refer to page 106 of the VB150

User’s Manual.
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Settings specified on the “Camera and Video” page (→ VB150 User’s Manual P.42)

Specify the appropriate settings for the Camera 1 being used.

5Settings specified on the “Preset” page (→ VB150 User’s Manual P.47, 77)

Set the camera angle for the area just inside the door as Preset 1.

Settings specified in the “Motion Detection Setting Tool” (→ VB150 User’s Manual P.82)

Sample Still Picture Recording Settings

● Select “Enable motion detection”.

● Select “Use scheduled motion detection”.

● Set weekend monitoring as the time for picture recording,

as follows:

Schedule 1 --- 20:00 Friday to 7:00 Monday

● Set the “Preset” to be used for shooting to Preset 1.

● To set the level of motion detection sensitivity that will

trigger an ON event, shoot a simulation of the actual event

and reproduce the amount of change that registers as an

incursion. In this situation, in order to capture the picture

variation that is recognized as the door opening and

someone entering the room, first position the motion

detection frame on the center of the door.

● Next, set the parameters for “Motion detected”.

To ensure that the event is not triggered by unrelated

lighting changes or small movements, set the “Duration”

parameter so that picture changes lasting a second or less

are ignored and then set the “Area Ratio” parameter so

changes that occupy 30% or less of the total picture are

also ignored.

● Then reproduce the conditions for someone entering the

room and check that the change in the picture is captured

by the red rectangle in the viewer. If the change is not

recognized, increase the sensitivity.

6



● Once the red rectangle in the viewer reliably captures the

intruder, check that the peak display in the detection

indicator gives a “Motion detected” result. If there is no

“Motion detected”, adjust the sensitivity, area ratio and

duration settings.

● Record the 4 seconds of video that precedes the “Motion

detected” event.

● Record 8 seconds of video after the “Motion detected”

event.

● Between “Motion detected” events, record pictures at 10

second intervals.

● Set the parameters so that a signal is sent to the warning

device at the same time as the “Motion detected” event

and discontinued 10 seconds later.

Operation of the Motion Detection Function Using a Schedule

7
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Viewing and Distributing Recorded Pictures

Use your Web browser to access the following
URL:

http://192.168.100.1/sample/lookup/
* Enter the actual IP address set for the VB150.

(→ VB150 User’s Manual P.36)

The “Sample Page for the Retrieval of
Recorded Pictures” shown at left appears.
Click the “Specify capture period with text”
link if you want to enter numbers to specify
the recording period to be searched, or click
the “Specify capture period with menu” link to
select the recording period from a menu.

Viewing Recorded Pictures

You can search and view recorded pictures by accessing the “Sample Page for the Retrieval of Recorded Pictures”. You can

search by trigger, by camera or by time interval from your browser and view pictures as images or as a pseudo-animation.

You can also distribute recorded pictures directly to users so that they can search and view the pictures in the same way.

When you select “Specify capture period with
text”, the Conditions for Image Retrieval
screen appears in window 1 at left.
● Select either “External Device Input”,

“Schedule” or “Motion Detection” as the
“Trigger”. External Device Input 1 and 2
correspond to the “External Device Input 1/2”
parameter on page 50 of the VB150 User’s
Manual, schedule 1-4 corresponds to the
“Schedule 1-4” parameter on page 52 and
motion detection corresponds to the Motion
Detection Setting Tool on page 82. Use the
“any” option to search all the options for the
respective parameter.

● In “Camera”, specify the camera number to be
searched. Select “any” to search all the cameras.

● In “Capture Period”, enter the date and time the pictures were captured.

Example 1/200204191830-20020420010530

Searches from 18:30:00 on April 19, 2002 to 01:05:30 on April 20, 2002.

Example 2/20020419-[blank]

Searches from 00:00:00 on April 19, 2002 to the present.

Example 3/[blank]-20020420

Searches from the oldest recorded pictures to 23:59:59 on April 20, 2002.

When you specify the search condition and click the [Retrieve] button, a list of the recorded dates and

times that meet those conditions appears in window 2. When you click on one of the listed items, the

corresponding picture and capture information appear in window 3.

1

2 3
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If you select “Specify capture period with

menu”, the Conditions for Image Retrieval

screen appears in window 1 at left.

● Select either “External Device Input”,

“Schedule” or “Motion Detection” as the

“Trigger”. “External Device Input1 and 2

correspond to the “External Device Input 1/2”

parameter on page 48 of the VB150 User’s

Manual, schedule 1-4 corresponds to the

“Schedule 1-4” parameter on page 50 and

motion detection corresponds to the Motion

Detection Setting Tool on page 80. Use the

“any” option to search all the options for the

respective parameter.

● In “Camera”, specify the camera number to be

searched. Select “any” to search all the cameras.

● In “Capture Period”, select the date and time

the pictures were recorded.

When you specify the search condition and click

the [Retrieve] button, a list of the recorded dates

and times that meet those conditions appears in

window 2. When you click on one of the listed

items, the corresponding pictures and capture

information appear in window 3.

By clicking “animation” in the list display, you

can view all the retrieved pictures in the list

continuously as a pseudo-animation.

Use the slider to vary the speed of the

animation.

Start/Stop buttonDisplays the position of the

current picture number relative

to the total number of pictures.

Drag to reposition.

1

2 3

e
Tip

Customize the Conditions for Image Retrieval page to suit the actual operation.

Click the right side of the picture to display

the next picture, and click the left side to

display the previous picture.

9
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List format. Specify “html” to specify a list display page, or “anim” to specify a page 
for SnapAnimator. If this parameter is omitted or an undefined value is specified, 
“html” is used.

type

Specifies the HTTP server and the IP address of the HTTP server. If this parameter 
is omitted, the IP address of the client side network interface is used*.

server

Target frame name for list display. Mandatory when a multi-frame configuration is 
used to construct the picture search page.

target

Language used to display the desc command attribute information. Specify “english” for 
English-language display and “japanese” for Japanese-language display. The default 
value is “english”. When an undefined value is specified, the default value is used.

locale

Specifies the range for the search results. Specify an integer of 0 or more for either. 
Of the list of recorded pictures that satisfy the search criteria, the list displayed 
excludes the number of items specified by the skip parameter from the beginning of 
the list and includes items up to the limit imposed by the limit parameter. If these 
parameters are omitted or erroneous values are specified, skip is set to 0 and limit to 
100. If limit is set to 0, no limit is applied.

skip/limit

Specifies the trigger that governs the main cause of picture recording. A setting of i0 
restricts any external device input, and i1 and i2 restrict external device input to 
inputs 1 and 2. A setting of s0 restricts any schedule setting, and s1, s2, s3 and s4 
restrict schedule setting to settings 1,2,3, and 4. m is motion detection. If this 
parameter is omitted, or an undefined value is specified, the trigger is unrestricted.

tn

Parameter Name Details

Camera number used for recording. Specify a value from 1 to 4 as the camera 
number. If this parameter is omitted or an undefined value is specified, the camera 
number is unrestricted.

cn

Start time for the recording period. Specify a setting using the “yyyymmddHHMMSS” 
format (yyyy: year; mm: month; dd: day; HH: hour; MM: minute; SS: second). If this 
parameter is omitted or an erroneous value is specified, the start time for the 
recording period is unrestricted. 
A part of the mm, dd, HH, MM, SS parameter can be omitted. The default settings 
are 01 for mm and dd, and 00 for HH, MM and SS.

ts

End time for the recording period. The specification format and the handling of 
omitted or erroneous parameters is the same as for ts. A part of the mm, dd, HH, 
MM, SS parameter can be omitted. The default settings are 12 for mm, 31 for dd, 23 
for HH, and 59 for MM and SS.

te

Pictures Search CGI

The pictures search CGI includes the “enum” command to generate a list of recorded pictures that

satisfy the search criteria, the “desc” command to generate the video data display page, and the

“data” command to retrieve the video data.

enum Command

The “enum” command is used to generate a list display page for the search page and to

generate a page for SnapAnimator. The items shown in the recorded picture list generated by

the “enum” command are displayed in order of the time they were recorded.

■enum Command Parameters

* This is a function that corresponds to address replacement using <_I_P_A_D_D_R_>.

However, you cannot specify <_I_P_A_D_D_R_> itself.

Viewing and Distributing Recorded Pictures
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Specifies the video data. This is the video data file name excluding the “.jpg” 
extension and is specified using the “yyyymmdd/HHQQ/HHMMSSCC” format. This 
parameter can not be omitted.

b

Specifies the HTTP server and the IP address of the HTTP server. If this parameter 
is omitted, the IP address of the client side network interface is used*.

server

Language used to display the desc command attribute information. Specify “english” 
for English-language display and “japanese” for Japanese-language display. The 
default value is “english”. When an undefined value is specified, the default value is 
used.

locale

Parameter Name Details

desc Command

The “desc” command is used to generate a video display page. The video display page uses

HTML text for the video display area and attribute display area, and uses the “data” command

described below to retrieve the video data.

■desc Command Parameters

data Command

The “data” command retrieves video data. The parameters only specify the video data and the

format is the same as the b parameter for the desc command. Specify the data directly as

“data?yyyymmdd/HHQQ/HHMMSSCC” with no parameter name. (QQ = every 15 minutes,

indicated as 00, 15, 30, or 45.)

11
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Distributing Recorded Pictures

Distributing pictures that have been recorded

If you forward a picture (JPEG) recorded with the Schedule recording function using FTP and

copy it, or remove the flash memory card, download the picture to a PC and embed the picture in

a Web page, you can create a still-picture distribution page.

Distributing pictures in SnapAnimator display format

Pseudo-animations (→ P.8) are created using the SnapAnimator applet. The following example is

a SnapAnimator description in a HTML source. Customize the description between <APPLET>

and </APPLET> to enter the picture in the place you want to paste it.

* The underlined text is an IP address. Enter the actual IP address set for the VB150.

Parameter Description

image0 
Specifies the URL of the picture file. When specifying multiple picture files, 
specify them successively as image1, image2, etc.

Specifies the time at which image0 was taken. Written in the “Y/M/D H:M:S” 
format.

■SnapAnimator parameters

time0

The above example was generated using an emum command for the picture search CGI. By using this

description to properly specify the image0 and time0 parameters, you can also create an picture distribution

page that displays any still pictures (JPEG) you have on hand as pseudo-animations. In this case, enter the

time stamp that corresponds with the name of the picture file that you want to display in the double-underlined

portion and enter the imageX and timeX parameters for the number of pictures which you want to display.

<APPLET CODEBASE="http://192.168.100.1/-wvdoc-01-/SnapAnimator/"

code="SnapAnimator.class"

      archive="SnapAnimator.zip" width=320 height=300>

<PARAM NAME=cabbase VALUE="SnapAnimator.cab">

<PARAM NAME=image0 VALUE="http://192.168.100.1/-vbidb-/data?20000102/

0300/03040507">

<PARAM NAME=time0 VALUE="2000/01/02 03:04:05">

<PARAM NAME=image1 VALUE="http://192.168.100.1/-vbidb-/data?20000216/

1000/10100713">

<PARAM NAME=time1 VALUE="2000/02/16 10:10:07">

<PARAM NAME=image1 VALUE="http://192.168.100.1/-vbidb-/data?20000316/

0100/01100815">

<PARAM NAME=time2 VALUE="2000/03/16 01:10:08">

 ...

</APPLET>

Viewing and Distributing Recorded Pictures
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Downloaded image displays

Pictures recorded with the VB150’s

picture recording function

Pictures periodically collected

according to the task

Using VBCollector

VBCollector is used to view pictures recorded by the VB150. With VBCollector, you can collect and display still

pictures recorded by the VB150 based on inputs from an external device, motion detection or schedules.

VBCollector accesses the VB150 at specific times expressed in units such as dates, weeks, or months, and then

downloads the recorded pictures. Since the recorded pictures are saved one after another in the PC on which

VBCollector is installed, pictures can still be securely saved when the allowable limit on the number of pictures that

the VB150 can record and save has been exceeded. Downloaded images can also be easily viewed in the Web

browser. Information related to task execution can also be recorded in a log.

VC-C4COMMUNICATION CAMERA
f:4-64mm 1:1.4-2.8

VB 150

Flash memory card

13
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c
Note

● Check the operating environment (→ VB150 User’s Manual P.20) before

starting installation.

● VBCollector cannot be installed on a PC where MV Ver. 2.0 or later version

is already installed.

To Install...

If any other applications are running, please exit

them before installation. Please also be sure to

close the Windows Service Panel.

Load the supplied CD-ROM into the CD-ROM drive.

Double-click “CltSetup.exe” on the CD-ROM to start

up the installer. Click the Next button.

2 If you agree to the clauses in the licensing

agreement, click Yes.

3 Specify the target directory for the installation and

click the Next button.

If you have no special directory preference, just click

Next.

1

4 Specify the menu name to be registered in the

Program menu of the Start button, then click Next.

Installing VBCollector

14



5 Check the settings and items you have selected thus

far, and click Next to confirm. The installation will

proceed by copying files and making registry

settings, etc.

Click Finish to complete the installation.6

When installation is complete, “VBCollector Task

View” is added to the Start menu.

15
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VBCollector is started up by choosing it from Start menu.

To Start Up VBCollector...

Choose [Program]-[WebView Livescope]-[VBCollector

Task View] from the Start menu to start up VBCollector.

Starting Up VBCollector

To use VBCollector, the network camera server (hereafter referred to as “server”) from which the

VBCollector downloads pictures must be registered.

Registering a Server

To Add a New Server...

To add a server, choose Add from the Server menu,

or click the Add button on the Server List dialog box

that appeared when Edit from the Server menu was

selected.

1

Adding a server

Add a new server to which VBCollector will download pictures.

Using VBCollector
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2 Enter the various fields and click OK.

■ Server Name

Assign a name for recognizing the Server.

■ Image Directory

Enter the name of the directory where downloaded images are to be saved, or click Browse to select a

directory folder. Refer to the next page for how to download images to a shared folder on the network.

Delete images on the server

When this check box is selected, pictures that VBCollector downloaded from the server will also be deleted

from the server.

■ Server information

Host Name (→ VB150 User’s Manual P.38)

Specify an IP address or a host name.

HTTP Port (→ VB150 User’s Manual P.57)

Enter the HTTP port number set in the server. (The default setting is 80).

Administrator Account (→ VB150 User’s Manual P.37)

Enter an administrator account registered in the server.

Administrator Password (→ VB150 User’s Manual P.37)

Enter the administrator password registered in the server.

Settings Page URL (→ VB150 User’s Manual P.37)

Enter the “Path” to the setting title page set in the server.

■ Proxy

Use Proxy Server

Select if connecting through a proxy server.

Host Name

Specify a host name or IP address for the proxy server.

Port

Enter a port number for the proxy server (The default setting is 8080).

■ PPP

Use PPP connection

Select if connection will be established by dialing up.

PPP Connection Name

Select a phone number from the phone book entry. A dialup network will need to have been installed and

the phone number will need to have been registered in the phone book.

Account

Enter the PPP account to be used for the dialup connection.

Password

Enter the PPP password to be used for the dialup connection.

17
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Using VBCollector

e
Tip

Downloading images to a shared folder on the network

● You cannot specify a path name that uses a networked drive in the “Image

Directory” setting. Use UNC notation to specify the path name.

\\Computer name\shared directory name[\path]

Eg) \\Server\Share\path

● Set the folder access privileges for the “Image Directory” folder so that read/

write operations can be performed from machines with VBCollector installed.

● In case of using VBCollector in Windows 2000/XP, make the logon account

setting for VBCollector task scheduler service in the following procedure (→

page 31)

1. Choose “Options” from “Tools” menu.

2. Select [Specify the executive account] under [Services] in the option

dialog.

3. Enter your user name and password.

4. Click “OK” button.

* Specify an account from which you can log on to the download

destination machine.

* Set the folder access privileges so that read and write operations can be

performed from the download execution account to the folder in which

VBCollector is installed (C:\ProgramFiles\Canon\WebView\VB\VBCollector\

1.1).

18



To Edit Server Information...

Editing Server Information

Content of the registered server information can be edited.

Choose Edit from the Server menu, and when the

Server List dialog box appears, select the server

name to be edited and click the Edit button.

To delete a registered server, click the Delete

button.

1

2 As with the procedure for adding servers, change all

desired items and click OK.

c
Note

Downloaded images are not deleted when a server is deleted. To delete

downloaded images, first follow the procedure in “Deleting Images” (→ P.

28) and then delete the server.

Registering Tasks

To Add a New Task...

To add a task, choose New Task from the Task

menu.
1

Adding a task

Add a new task for downloading images.

19
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■ Task Name

Assign the task a name.

[Enable this setting]

Select “Enable this setting” if the task is to be performed according to the schedule. If not selected, the

added task will not be executed.

■ Server Name

Select the server from which the VBCollector downloads recorded pictures. The server will need to have

been registered in advance.

Server Settings

Any download server name can be registered (→ page 17). After registration, it can be selected from the

“Server Name” column.

■ Schedule

Start Date

Set the date which is to be the starting point of the schedule. The task will be executed after the specified

start date according to the criteria specified below.

Start Time

Set the time when the task is to start up (in 24-hour format).

Once

Select if the task is to be executed only once. The task will be executed only once at the start time on the

start date.

Daily

Select if the task is to be executed once every certain number of days. This number of days can be

specified between 1 and 31.

Weekly

Select if the task is to be executed every certain number of weeks on a certain day of the week. Set the

number of weeks between 1 and 53, and specify the day of the week.

Monthly

Select if the task is to be executed every month on a certain day of the month. Set this day between 1 and

31. Or a day of the week for a certain week of the month can also be specified.

■ Details

Repeat task

Select this checkbox to repeat the task at set intervals. Images are downloaded repeatedly at the specified

intervals from the Start Time to the End Time specified in the schedule. If this checkbox is left unselected,

images are downloaded once at the Start Time specified in the schedule. Once the End Time is reached,

the task is not performed. Images can be downloaded at intervals of some minutes or by specifying a

number. Enter a value between 5 and 1439 as the number of minutes. Times up to the Start Time plus

23:59 can be specified as the End Time.

Retry when an error occurs

Select this item if a task is to be executed again in the event a download does not end normally after a task

is executed. The task will be executed again a specified number of times at specified time intervals. During

this time, if the download is completed normally, further tasks will not be repeated. Specify the number of

times and the time interval at which a task is to be re-executed. For the number of times, enter a value

between 1 and 10; for the interval, enter a value between 1 and 10.

Disconnect after finishing download (for access via dial-up connections)

If the connection with the server is a dialup connection, when this item is selected, it will automatically be

disconnected when the task ends.

Enter the various items and click OK.

Using VBCollector
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To Edit a Task...

Editing Tasks

The details of a registered task can be edited.

In the Task View, select the task to be edited by

clicking on its name, then choose Edit Task from the

Task menu. Or, double-click on the task to be edited.

To delete a registered task, choose Delete Task

from the Task menu.

1

2 As with procedure to add a new task, change all

desired items and click OK.

Executing a task

Registered tasks are executed automatically according to predetermined schedule when “Enable

this setting” is selected at Task Settings. If you want a task to be executed immediately, select the

desired task on the Task View and choose “Execute now” from the Task menu.

Executing and Canceling Tasks

c
Note

● Up to 16 tasks can be executed by VBCollector simultaneously. Please be
sure not to load a schedule with 17 or more tasks to be executed.
VBCollector is also not able to execute multiple tasks simultaneously to the
same server. Please take care to ensure that multiple tasks are not
executed to the same server by taking such measures as leaving a
sufficient time space between the “Start Time” of each task.

● If you carrying out the maximum of 16 tasks simultaneously, please be
aware of the performance of the PC on which VBCollector is to be installed.
(→ VB150 User’s Manual P.20)
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Canceling a task

To disable a registered task, clear “Enable this setting” at Task Settings. To abort the execution of

a task, in the Task View, click on the task to be aborted, and choose Abort in the Task menu.

Using VBCollector
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To View Task Status

Display task status

During the execution of any task, the download status can be checked. Once the logon account

setting for service is made (→ page x), no status display is available.

During the execution of any task, Choose “Status”

from “Task” menu or the task whose status display is

desired to make a right-click. From the displayed

popup menu, choose “Status”

1

2 Check the status display of download and click

“Close” button to close the dialog box. If you want to

cancel the download, click “Cancel” button.

■ Status

Shows the progress of download.

■ Target Server

Shows the connection status with the server.

[Host Name]

Shows the host name of image download server set in the server information (→ page 17).

[Image Directory]

Shows the name of the folder, set in the server information (→ page 17), where any downloaded image is

to be saved.

[Delete images on the server]

When it is selected, any recorded image after download will be deleted from the server. In order to change

the checking status, change the setting in the server information (→ page 17).

■ Close the dialog automatically when downloading completed

After download is finished, this dialog will automatically be closed. During download, it is always selected.



The execution status can be checked on the Task View.

Details Displayed on the Task View

● Task Name

The names that were specified at Task Settings are displayed here. The status of each task

is displayed as an icon at the left of the name.

Running This task is currently being executed.

Waiting This task is currently standing by to be executed at the next

scheduled execution time.

Disabled “Enable this setting” for this task is not selected at Task Settings

and is currently not being executed.

Not scheduled This task is not currently scheduled for execution.

Settings damaged Inconsistencies have occurred in this task’s settings and the task

will not be executed.

● Server Name

The server names that were specified at Task Settings are displayed here.

● Next Run Time

The date and time when the task is to be executed next is displayed here.

● Last Result

The last results achieved by the task and the task end time are displayed here.

● Schedule

The start date, start time, and execution interval for each task are displayed here.

Refreshing Task View Display Content

To update the Task View content to reflect the most recent information, choose Refresh from the

View menu.
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Viewing Recorded Images

Displaying Images

Downloaded images are selected by server name and date, and displayed in a Web browser.

The images that were downloaded according to the task schedule are saved in the folder specified

at Server Information. VBCollector includes a function that outputs images to a Web browser to

simply viewing.

To View Pictures...

Choose Display Images in the Tools menu.

2 The Image List dialog box appears. Select the

server name to be viewed, select the date of the list

to be displayed, and click the Display Image.

1

Using VBCollector
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Starting/Stopping the Service

The task scheduler service can be started and stopped.

To Make Settings...

Choose Start Service or Stop Service from the Tools

menu. If the service has started, Stop Service is

enabled in the menu; if the service is stopped, Start

Service is enabled.

2 When the Confirmation dialog box appears, click

OK.

1



4

5 When Detail Display above the frame is clicked,

detailed information on the images in the thumbnail

screen is displayed. Click on the image to be

viewed; it is displayed in the original saved

dimensions.

HTML for displaying the images is generated, the

Web browser starts up, and thumbnail images of the

selected date are displayed in 100-image units on

the page. Click on the image to be viewed; it is

displayed in the original saved dimensions.

25

3 When the confirmation dialog box appears, click OK.

To View Animation

1

Animate images

Downloaded images can be selected using the server name and date to be animated

(consecutive display). The images can also be shown in detail or zoomed in/out.

Choose “Display Images” from “Tools” menu.
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Image List dialog will be displayed. Select the name

of the server where you want to browse and click-

select the date of any image to be animated. Then,

click “Animation” button.

2

Animation dialog will be displayed. As dialog size,

large or normal size is available and is automatically

selected depending on the original image size.

3

Status bar
Shows the image file name and “Current image number/
total number of images”.

Image data display area
Shows the detail image data.

Display Image area
Shows any image of the selected
recording date. If the image size is
greater than the display area, the
image display position can be moved
with scroll bar.

● Animation

Images can consecutively be displayed.

[Top] button the original image.

[Prev] button Shows the previous image.

[Play/Pause] button Plays/pauses the animation.

[Next] button Shows the next image.

[Last] button Shows the final image.

[Speed] bar Controls the speed of switching images.

e
Tip

During animation, [Top], [Prev], [Next] or [Last] button cannot be used. If you want to

use any, click [Play/Pause] button to stop the animation.

Using VBCollector

26



To Delete Images...

Choose Delete Image from the Tools menu. In the

Image List dialog box, select the name of the server

that the VBCollector downloaded the images to be

deleted, select the date to be deleted by clicking on

it, then click the Delete Image button.

Deleting Images

Downloaded images can be deleted.

● Zoom in/out

Images can be zoomed in/out.

[Magnification] Shows the current magnification (10~500%).

[Zoom in] button Enlarges images by 10%.

[Zoom out] button Reduces images by 10%.

[Move] button If any image size is greater than the display area, you

can move the image display position. Clicking “Move”

button to position the mouse cursor on the image

changes the cursor into.  Move  while pressing

the left mouse button on the image. The image

display position will be moved.

● Change dialog size

As dialog size, large or normal size is available and is automatically selected depending on

the initial image size. However, you can also change it manually.

[Large size] button When it is clicked, the dialog will be displayed in large

size. It appears in case of normal dialog size.

[Normal size] button When it is clicked, the dialog will be displayed in

normal size. It appears in case of large dialog size.

27



P
icture R

ecording U
ser’s G

uide

Using VBCollector

Viewing Logs

The following information about logs is displayed:

● Code

Identification codes are displayed here. Four types of icons representing the level are also

displayed with these codes.

Information level

Warning level

Error level

Unknown

● Date & Time

The date and time when the log was generated is displayed here.

●  Task

The name of the task that output the log is displayed here.

● Server

The name of the server to which the task performs downloads is displayed here.

● Message

The log’s message is displayed here.

VBCollector outputs logs concerning the execution of tasks. To view a log, choose Display Log

from the Tools menu.

28

To Set Display Criteria...

Choose Filter from the View menu.1

Displaying logs according to selection criteria

Logs can be filtered according to type, code, or date and time so that only the required information

is displayed.



The Filter dialog box appears. To display only the

logs that match the specified criteria, enter the

criteria below and click OK. If no changes are

required, click Cancel.

2

[Specify Task.]

Select if filtering by task name, then enter the task name.

[Specify Server]

Select if filtering by server name, then enter the server name.

[Error Type]

Specify the error type when filtering by error type.

● Not Specified

Selecting this item disables priority and code settings.

● Specify Priority

From Error, Warning, or Information, select the error level to be displayed.

● Specify Code

Select if only logs with the corresponding identification code are to be displayed,

then enter the identification code.

[Date & Time]

Filters logs by output date and time.

● Specify Start Date & Time

When this item is selected and a date and time is entered, logs generated after the

specified start date and time are displayed.

● Specify End Date & Time

When this item is selected and a date and time is entered, logs generated before the

specified end date and time are displayed.
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To Search Logs

Choose “Search” from “Edit” menu or press “Ctrl+K”

on keyboard.

Logs can be searched using character strings. This function is convenient in case of searching any

target log from among numbers of logs.

1

Search logs



P
icture R

ecording U
ser’s G

uide

Using VBCollector

30

Search dialog will be displayed. Entering the

character string you want to search in “The

Character search” and clicking “Search” button

starts searching from the initial log. If you select any

log, searching will be started from the selected log.

Clicking “Cancel” button closes the search dialog.

2

[Distinction of a capital and a small letter]

When it is selected, capital and small letters will be distinguished and only those

strings, which exactly coincide with the entered character string, will be searched.

A line containing the relevant character string will be

highlighted. Pressing “F3” on keyboard starts

forward search. Pressing “Shift+F3” makes

backward search. When searching is completed

after taking a round, the message “Searching has

been completed.” will be displayed to terminate

searching. If the relevant string is not found, the

message “The reference item was not found.” will be

displayed to quit searching.

3

How to select logs

Choose “Open” from “Display” menu.

The initial log file of VBCollector is saved as “vbrpd.log” file in the “SYSTEM” folder within the

VBCollector-installed directory. When the “vbrpd.log” file exceeds the size of 10 MB, it will be

renamed as “vbrpd01.log”, creating a new “vbrpd.log” file within the same folder to save the log.

Log files can be created up to 10 (with names from “vbrpd.log” to “vbrpd09.log”): The newest log file

is always named as “vbrpd.log” and the older ones are renamed increasing their numbers

whenever a new one is created. VBCollector Log Viewer can selectively display any of created log

files.

1

Selecting log files

Choose the log file you want to display and click

“Open”. The selected log will be displayed.
2

To Make Settings...

Choose Options from the Tools menu.

The response to be taken when the specified available capacity on a target drive has been reached

or the upper limit number of pictures can be set when executing downloads based on a task

schedule.

1

Setting the Download Capacity



Option dialog will be displayed. Enter the required

items to click “OK” button.
2

■ Disk Space on Image Directory

Min. amount of free space required on image directory

Set the ratio of minimum free space to 1~50% for a drive containing the folder where you want to save any

image (→ page 17).

What to do when min. is reached

When the free space of destination drive reaches the ratio set in [Min. amount of free space required on

image directory], set how to deal with it.

● Abort task

Cancels download.

● Delete old image [s]

Sequentially deletes downloaded images being recorded on the server from the image of the oldest

shooting date until the specified free space ratio can be recovered.

■ Details

Set max. number of pictures per download

When it is checked, the maximum number of images to be downloaded from the server at a time can be set

to 1~30,000.

Specify the execution account

When it is checked, the execution account of download can be specified. Set it when you want to download

any image on the shared folder on the network from the server (→ P.18). (Windows 2000/XP only)

Once selected, enter you user name and password.
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